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Letôs get started 
 
 
This manual gives an introduction to Archive Manager Exchange Edition Enterprise Manager 
(hereinafter only ñEnterprise Managerò or ñEMò) ï the administrative tool used for email 
archiving, retrieving and management. It explains how to work with the tool and how to set 
global as well as specific criteria for automated email archiving. 
 
 

How to read this manual 
 

1. For basic information, please read the INTRODUCTION first. 
  
2. The next short chapter ñEnterprise Managerò will guide you through the structure of 

Enterprise Manager. 
  
3. Then you will need to proceed with the chapter ñGlobal archiving settingsò describing 

how to specify your settings for archiving. 
  
4. As a next step you will need to specify: 
 - the retention time, i.e. time for which your emails should be archived (see the section 

ñRetention tabò), 
 - jobs, i.e. scheduled tasks executing automatic archiving (see the section ñJobs tabò). 
  
5. Then define other settings according to your needs and company policy. 

 
The ñAdvanced Searchò section at the end of the manual deals with searching in archive. 
Except searching for desired items in archive, Archive Manager Exchange Edition Advanced 
search feature includes exporting of found data to mailbox or PST file.  
 
NOTE: Use the Table of Contents to quickly find sections and information you need. The 
manual is based on the structure of Enterprise Manager. 

 
 
 
 
 
 

Prerequisite knowledge 
Working knowledge of MS Exchange Server 2000/2003/2007/2010 and of MS Outlook is a 
must. 
 

Super-user 
When installing Archive Manage Exchange Edition we mentioned that our software will be 
running under a super-user having been assigned special rights (see ñInstallation Guide for 
Archive Manager Exchange Editionò). In this manual we will be referring to the super-user as 
well; this super-user will be referred to as srv_exchange user. 



 

Manage, Migrate , Archive , Store , Protect  

 

  

www.metalogix.com/Support                 sales@metalogix.net                  Metalogix Software   7 / 270 

 

 

 
INTRODUCTION ï Basic terms explanation 

 
Archive Manager Exchange Edition archiving solution offers long-term storage of emails with 
easy search and retrieval capabilities saving the space on the MS Exchange Server. Basically, 
it replaces the email on the MS Exchange Server with a link or a ñshortcutò of a configurable 
size and saves the email on an external storage devices such as HDD, Jukebox Systems 
(AMASS and Pegasus), tape, EMC Centera, DVD, CD_ROM, SAN, NetApp, JVC and thus 
releasing the space on your mail server up to maximum. 
 
There are three methods of archiving (i.e. replacing the email with a shortcut) available with 
Archive Manage Exchange Edition: 

ǒ Manual archiving (Archiving of individual emails one by one in Enterprise 
Manager / Archive view.) 

ǒ Direct archiving (Archives all emails immediately upon their arrival. If you 
want to use this way of archiving, the DirectArchive extension of Archive 
Manage Exchange Edition has to be installed on the MS Exchange Server.) 

ǒ Archiving by scheduled tasks ï JOBS (Administrator can set the specific 
criteria for archiving: groups of users that are to be archived, mailbox folders 
that are to be archived, retention times for which the emails will be stored etc. 
Scheduled archiving then runs in the background with pre-defined settings.) 

 
Individual users themselves are still able to work with their archived emails as with any other 
non-archived emails. Moreover, having the Archive Manager Client AddIn installed they can 
archive and restore their emails as well. Accessing emails over the Internet is possible using 
the Archive Manager OWA support. ArchiveWeb is used for working with archived emails. 
In this way they are accessible even if the MS Exchange Server is down. 
 
Enterprise Manager as an Archive Manage Exchange Edition application provides you with 
many more useful features. Manual archiving as well as manual restoring of emails is available 
together with email and shortcut recovery and repair. The optional full-text search engine is a 
valuable feature which enables you to search through emails and their attachments. 
Global settings apply if no specific settings are selected. With Global settings you will easily 
configure the most basic archiving parameters as enabling DirectArchive, compression of 
archived files, default retention category, shortcut size and others. 
Time for which your emails are stored is set via Retention categories. To store emails for 
various time periods you can archive them under different retention categories.  
To secure loadbalancing, more Archive Manager archive servers can be installed. In this 
multiple server environment servers are distinguished by their Location ID.  
Administrators will appreciate possibility to implement their individual requirements for 
archiving through Scripts.  
Post Processing allows customer specific tasks to run on archived emails. 
 
It is generally understood that backup of the data is essentially important. With Archive 
Manage Exchange Edition it can be done ñon the flyò as our software is able to store items in 
two different locations at the same time (see ñMultiple saving in HSMò document). Then in 
case of any unforeseen circumstances you have a disaster recovery plan and no loss of data. 
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Enterprise Manager 
 
In Enterprise Manager (EM) you can set many useful criteria for automated email archiving. 
With the use of EM you can specify when, in what way, and which of the groups of mailboxes 
will be archived automatically. Archived items can be retrieved and restored anytime. 
 
NOTE: In Enterprise Manager mailboxes are displayed with a unique ID number ï the mailbox 
ID (in square brackets). It is useful in cases when two mailboxes have the same display name. 
This will help administrator identify the correct mailbox. 
 

Before archiving with Enterprise Manager 
 
Before archiving with EM all users and groups whose mailboxes you plan to archive need to 
be synchronized with Archive Manage Exchange Edition Server (see ñInstallation Guide for 
Archive Manage Exchange Editionò). Keep in mind that archiving cannot be applied to emails 
received by mailboxes that were not synchronized with the Archive Manager Server. 
 
The synchronization process can be automated, i.e. the synchronization can be scheduled in 
the Enterprise Manager \ Tools \ Addressbook Manager and can run in the background 
(see ñInstallation Guide for Archive Manage Exchange Editionò).  
 
When mailboxes are synchronized with Archive Manager Server you may start archiving with 
Enterprise Manager. 
 
NOTE: The archiving services are configured to run automatically (service type set to 
ñAutomaticò in Start \ Settings \ Control panel \ Administrative tools \ Services) and some 
of them are running under the super-user account. If some services are not started, it is 
necessary to start them manually using the included Start.bat batch file under C:\Program 

Files\ Metalogix \ MAM4Exchange \Tools.  If it does not help, please review the event log 

entries (Start \ Control panel \ Administrative tools \ Event viewer). The most common 
problem of not starting services is the incorrectly configured identity ï in this case either run an 
update (repair) of the Archive Manage Exchange Edition setup or correct the service 
identities manually (using Start\Programs\Administrative Tools\Computer Management). 

 

The structure of Enterprise Manager  
 
Run EM (click Start\ Programs\ Metalogix \ Archive Manager Exchange Edition \ 
Enterprise Manager or run it from C:\Program Files\ Metalogix \ MAM4Exchange \ 
Applications\ EnterpriseManager\ PamEnterpriseMan.exe). This will open the Enterprise 
Manager window.  
 
As default you can run the EM only with the super-user account that was specified during the 
installation. If you try to run EM while logged on with different user, the notification dialog 
appears. It will inform you that your user does not have enough permission to log on: 
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You can grant logon permissions to users in EM on the Tools / Options / User Roles tab (see 
the section ñGlobal archiving settingsò). Those users will be also able to run the EM and 
manage archiving. 
 
 
There are three different views in Enterprise Manager:  

 Manager,  
 Status, and  
 Archive.  

Switching between them is easy: 
- just press CTRL 1, CTRL 2 and CTRL 3 or 
- click the respective icons in the lower left corner in EM or 
- open the View menu and select Manager, Status, or Archive. 
 

 
 

NOTE: Enterprise Manager opens by default in Manager view. 
EM can run in Full Access or Read-only mode. In the Read-only mode the configuration is 
locked, but Archive management (Archive view) is not affected. So even in read mode you can 
manually archive/restore. Only settings cannot be changed. 
 

 

Manager view 
 
This is the most important view. It is used to configure AUTOMATED ARCHIVING done by 
jobs. Later you will learn how to define jobs and other helpful settings. 
On the screenshot below some of the groups are displayed in green. Green color indicates 
that groups have been enabled for automated archiving. 
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Status view 
 
By selecting Status view you will display information on current version of Archive Manager, 
status of Archive Manager (MAM) services (running, stoppedé), logged on users, database, 
HSM Store etc. 
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Archive view 
 
This view is reserved for MANUAL ARCHIVING and RESTORING, i.e. for archiving / restoring 
of individual items one-by-one. Archiving / restoring of a specific folder or mailbox is also 
available. 
 
NOTE: Restoring = item from archive is copied back to Exchange server. 

 
 
 

Toolbar icons 
 
On the toolbar you will find a set of icons, through which you can access almost every 
standard command and function. They are accessible depending on what view you have 
selected and what you are working with at the time (e.g. Manager view, Groups tab, etc.). 
Those icons were designed specifically to enhance productivity and save time by easily 
pinpointing a specific command. 
Toolbar icons include (in this order): Properties, Refresh, Copy settings, Paste settings, 
Remove, Create new job, Schedule job, Stop job, Archive, Restore, Search in archive, 
Show legend and Open Addressbook Manager. We will describe each of them when they 
are accessible in different views and on different tabs. A comprehensive description can be 
found in the chapter ñToolbar icons ï Descriptionò. 
 

 
Toolbar icons 
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Change server 
 
Via Enterprise Manager administrator can connect to and administer also other Archive 
Manager servers, if such are installed. To do so, on the Session menu click Connect to 
server. New window pops-up. Switch to Remote host and enter the name of the server you 
want to connect to in the Server name combo box. Then click OK. 
 

 
 

To access the server installed on the local computer, switch to Local host and click OK. 
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Global archiving settings 
 
Global settings apply if no specific archiving settings are selected. There are many global 
settings which you may configure to your needs. They include, for instance, compressing of 
emails and their attachments, setting up the default retention category depending on e.g. legal 
requirements, enabling direct archiving, managing roles for different users etc. Settings having 
been specified under Tools/Options and Tools/Settings are used as the default for manual 
as well as automated archiving. 
 
 

Tools/Options 
 
Run Enterprise Manager (EM) (click Start/ Programs/ Metalogix / Archive Manager 
Exchange Edition / Enterprise Manager). In the EM window click on the Tools menu, and 
then click on Options to open the Options window. Here, on different tabs you may set your 
global archiving settings. 
 

 

Server settings 
 
Server role tab 
Archive Manage Exchange Edition is a product of high scalability and users can decide for 
various LAN solutions. Besides the simplest solution with one Archive Manager server, more 
complex configurations are possible, e.g.  

¶ ONE archive server (server assigned Archive server role) 

¶ retrieve server(s) (server(s) assigned Retrieve server role) and/or  

¶ PST import server(s) 
All in ONE Location, i.e. Location ID of all servers is ñ1ò. 
 
NOTE: In case of large organizations scattered around the globe, Archive Manage Exchange 
Edition provides you with the possibility to configure several Locations, i.e. several Archive 
Manager Archive servers distinguished by a unique identifier ï the LocationID. (For more 
information on Locations and LAN configurations see the ñFull Install Guide for Archive 
Manaò.) 
Recommendation: 

¶ When more than 1000 mailboxes are being archived, we recommend 
dedicating a separate machine as Archive Manager Retrieve server besides 
the Archive Manager Archive server 

¶ Maximum 3000 mailboxes can be archived with one Archive Manager Archive 
server. For more mailboxes it is necessary to install another Archive Manager 
Archive server, i.e. to create a new location with a new location number 

 
 
As you can see each server has its role in the environment. This server role has to be 
assigned to the server on this tab in the Server role down-drop box. Possible server roles are: 

¶ Archive server (only 1 Archive server per location is allowed) 

¶ Retrieve server 

¶ PST Import server 
After you have assigned roles to your servers it is necessary to register them on the 
Locations tab of the EM (see the section ñLocations tabò). 
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IMPORTANT NOTE: If there is only 1 Archive Manage Exchange Edition server in the 
environment, it has to be assigned ARCHIVE SERVER role. 
 
 
Public Folders tab 
On this tab you may specify the user whose public folders you want to display in Enterprise 
Manager. In the Public Folder access down-drop box specify the mailbox which will be used 
for reading and modifying the public folders. 
 
NOTE: Public Folder access is by default set to super-user (in our case srv_exchange) ï so 
that all public folders could be displayed on the Public folders tab (in Manager view as well 
as Archive view), and you could assign jobs to them. However, if you plan to assign jobs to 
public folders of only a specific user it is good to have only his public folders displayed. So - for 
viewing public folders of a desired user set the ñaccessò to that user. 
 
IMPORTANT NOTE: Please notice that your super-user has to be given owner rights over all 
public folders whose content is intended to be archived. 
 
 
To change the Public Folder access mailbox so that only its respective public folders are 
displayed on the Public Folders tabs (in Manager view as well as Archive view): 

1. On the Tools menu, click Options. 
2. In the Options window, click on the Server settings / Public Folders tab. 
3. Click the browse button next to the Public Folders access box to open the 

Select mailbox window. 
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4. Type the respective mailbox name in the offered dialog or select the 
appropriate user in the list which is displayed in the list box below and click 
OK. 

 
 

5. Finish by clicking OK in the Options window. 
 

Public Folder permissions are ñnot selectedò by default. You need to change it only if you 
want to add permissions (permissions in archive) over the whole public folder hierarchy for 
a specific user or group. Please note that this permission is applied for OEM storages and for 
external fulltext engines. 

 
 
 
 
 
 
 
 

Auditing tab 
 
If Auditing feature was installed, you need to enable it on this tab. To enable auditing, check 
Enable Auditing check box. In the Server Name enter the name of the machine where the 
Auditing feature is installed and specify the Server Port (the default port is 7783). Click Apply. 
NOTE: For more information on Auditing see the ñAuditing manualò. 
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Archiving settings 
 
Compression tab 
On this tab you may specify your compression criteria. Compressing is then done ñon the flyò.  
 
To specify compression criteria: 

1. On the Tools menu, click Options. 
2. In the Options window, click on the Archiving settings tab. 
3. To compress .MSG files, simply select the Compress .MSG check box. To 

compress attachments, select the Compress attachments check box. If you 
have decided to compress attachments, yet wish to exclude some types of 
attachments from compression, you can specify that in the Excluded 
extensions text box ï the respective attachments will not be compressed 
(such as .zip files etc). Simply enter the respective extension in the text box 
and click Add. Do not forget to finish by clicking OK. 

 
NOTE: When specifying Excluded extensions you can use the following wildcards: ñ*ò stands 
for any number of characters and ñ?ò stands for any single character. 
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Retention tab 
For legal reasons some emails must remain retrievable for many years. Our email archiving 
solution uses the Hierarchical Storage Management system (HSM). HSM offers the possibility 
to organize documents in a logical way, e.g. some documents need to be stored for a longer 
period than the others. In the HSM system you may define different ñretention categoriesò for 
each type of document (for example, one retention category for short-term documents and 
other retention category for long-term documents). 
 
On this tab you may choose which retention category should be used as default for archiving 
items if no specific retention category is chosen. It usually applies for manual archiving using 
Archive Manager Client Addin and for direct archiving (see ñDirectArchive tabò). 
 
However, every group or user can have its own default retention category assigned. This can 
be done on the Manager view / Settings / Group level retention tab (see the section ñGroup 
level retentionò in the ñSettings tabò chapter). Retention category set as default on this tab 
applies also to Global settings on the aforementioned tab ï and vice versa. 
 
NOTE: If you are running Archive Manage Exchange Edition for the first time, just one 
retention category is available. It is the default retention category created by the setup. 
Otherwise you can choose from all retention categories from the previous settings and you can 
also create your own on the Retention tab of the Manager view. 
 
For more information regarding retention categories see the section ñRetention tabò. 
 
You may still archive email items under different retention categories (not the default one). 
That can be specified through jobs, since for each job you may assign either a desired 
retention category or the default one. This topic will be described later in the ñJobs tabò section 
of the ñManager viewò chapter. Moreover, it is possible to choose the desired retention 
categories for an individual item when it is archived manually in the Enterprise Manager (see 
the ñArchive viewò chapter). 

  



 

Manage, Migrate , Archive , Store , Protect  

 

  

www.metalogix.com/Support                 sales@metalogix.net                  Metalogix Software   18 / 270 

 

 

 

 
 
 
 
 
 
 
 
 

Shortcut tab 
Here you can set the layout of archived emailsô shortcuts, i.e. you can set how the archived 
emails will be displayed in the Outlook preview pane. The layout and the type of shortcut are 
defined through templates. The template specified on this tab will be used in cases when no 
other shortcut template settings apply. 
NOTE: Shortcut templates can be created under Manager view / Settings / Shortcut 
templates. Then they can be assigned to different users or groups under Manager view / 
Settings / Shortcut to user assignment. 
 
In the Default shortcut template downdrop box select a shortcut template from the available 
ones. Then click Apply.  
Default shortcut template can be set also under Manager view / Settings / Shortcut to user 
assignment / Global settings. If the default shortcut template is changed there it is changed 
also on this tab and vice versa. 
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Links 
If you plan to use attachment links in shortcuts (either Create links for attachments or 
Generate an HTML shortcut from template option from the previous tab) you need to 
configure the link generator server on this tab. 
In the Alias for attachment link URL enter the alias of your Archive Manager Archive server - 
the link generator server name. The ALIAS of your Archive Manager server can be accessed 
both from inside and outside the LAN. 
NOTE: We recommend creating an ALIAS (DNS alias) for the Archive Manager Archive 
server. It will serve as a virtual name and changing the physical name of the Archive server 
will not affect the attachment links. 
 
If the https channel will be used, check the use SSL check box. 
 
Check the Always generate attachment links check box to make the attachment accessible 
in all shortcuts. Independent of the settings specified on the previous tab (Shortcut tab), links 
to attachments will be always accessible from the Preview pane. They will bear the name of 
the attachment with an .html extension.  
 
After modifying these settings click Apply. Then click Yes to restart the relevant service. 
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Advanced 
This tab offers additional archiving settings:  
If you do not want to archive unread emails, check Disable unread message archivation. 
If appointments and/or tasks are planned to be archived, it is a good idea to disable archiving 
of appointments/tasks which are not finished. To do so, click Disable not finished 
appointment and task archivation. 
 
NOTE: Since v5.0 Archive Manage Exchange Edition supports only UNICODE archiving. 
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Message Classes  
 

Supported Classes tab 
MS Exchange stores emails and other objects in its database. We are referring to these 
objects as items. Each item has its own message class, which defines the type of the item: 
message, post, appointment, etc. Since the handling of these items is different, different 
shortcuts are created for each item type. By default only some message classes are archived 
(IPM.Note, IPM.Post, IPM.Document etc.). Additional item types to be archived can be defined 
on this tab. 
 

Sample message classes 

IPM.Note message 

IPM.Post message posted to a folder 

IPM.Fax  a fax message  

IPM.Document a file added to the folder (the base class never 
appears, it always contains the file type, e.g. 
IPM.Note.Document.Word.8) 

  

IPM.Appointment calendar item; a recurring calendar item 

IPM.Task an Outlook task 

IPM.Contact an Outlook contact 

  

IPM.Activity an Outlook journal message 

IPM.StickyNote an Outlook sticky note 

REPORT.IPM.Schedule.Meeting.Request a meeting request 

 
For a complete list of message classes, please refer to: 
http://msdn.microsoft.com/en-us/library/aa204771.aspx 
 
The following message classes and its subclasses are supported message classes by default, 
i.e. they can be archived by Archive Manage Exchange Edition:  

¶ IPM.Note,  

¶ IPM.Post,  

¶ IPM.Document,  

¶ IPM.Fax 

¶ IPM.Appointment 

¶ IPM.Task 

¶ IPM.Contact 
NOTE: Make sure they are not disabled on the Disabled Classes tab, if you want to archive 
them. 
 
Archiving of calendar items (IPM.Appointment), contact items (IPM.Contact) and task items 
(IPM.Task) is supported with some limitations. When a shortcut is created from such item, it 
becomes read-only which prevents further modification of the item. It can only be modified by 
Archive Manager Outlook Addin. If these items change constantly, we recommend archiving 
these items with ñKeep the original emailò or ñDelay shortcut creationò option (see ñRetention 
tabò part of the manual). Please note that recurring appointments and tasks are not archived.  

 
If appointments are planned to be archived, it is a good idea to disable archiving of 
appointments which are not finished. It can be set on the Tools/ Options/ Archiving settings/ 
Advanced tab (Disable not finished appointment and task archivation option). 

http://msdn.microsoft.com/en-us/library/aa204771.aspx
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In addition to the default supported message classes you can define additional message 
classes which should be archived:  

1. On the Tools menu click on Options.  
2. In the Options window, click on the Message Classes tab.  
3. Click the Add button to open the message classes list. Select one or more 

message classes which you want to archive. You can also specify different 
message class in the text box below the list. 

 
By default there is no need to fill in the Shortcut message class based on field. Leave this 
field blank or choose one option from the down-drop list. In this way you will define which type 
of shortcut will be created when the selected message class is archived. Please note that 
specifying of a new shortcut message class can have undesired effects. To get more 
information about this option, contact our support. 
 

 
 

4. Then click OK. Then click Apply. 
5. Upon clicking Apply, the message will inform you that you have to restart 

MamExHandler service: 
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Disabled classes 
Classes which you specify on this tab will not be archived. You can either check the desired 
message class(es) or click the Add button to choose from the list of additional message 
classes. You can also specify different message class in the text box below the list. When you 
have chosen the desired message classes in the list, click OK, then click Apply on the 
Disabled Classes tab. 
 
NOTE: If a message class is specified on the Supported Classes tab as well as on the 
Disabled Classes tab, it will NOT be archived. 

 
 

Search settings 
 
If you have selected to install Archive Manager Search service during installation you may use 
our full-text-search functionality.  
To enable Archive Manager Search feature, select the Archive Manager Search Server 
switcher on the Search settings tab. If you select Do not use fulltext, full-text-search 
functionality will be disabled. 
NOTE: To use the Archive Manager Search, you need to upload and enable the appropriate 
post-processing plugin. It is done after installation on the Post Processing tab of the EM. The 
plugin is called PFPPLuceneIndexPlugin and can be found in C:\Program Files \ Common 
Files \ Pam \ Services \ PamPostProcessing \ Plugins. 
 
In case of updating 
In previous versions of Archive Manager, Legacy fulltext was used as a full-text-search engine. 
If you continue using this legacy fulltext, please select the Legacy fulltext switcher. Then in 
the Fulltext server text box enter the name of your fulltext server. 
Moreover, you have to configure the following registry key: 
HKEY_LOCAL_MACHINE \ SOFTWARE \ Heilig & Schubert \ exchangePAM \ 
USELEGACYFULLTEXT (DWORD) 
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- this registry key has to be set to value ñ1ò 
If the key is not defined or the value is 0, the old fulltext (Legacy fulltext) cannot be used. 

 

 
 

User Roles 
 
As default, only the super-user, which was specified during the Archive Manage Exchange 
Edition installation, has logon permissions to Enterprise Manager. On this tab you can add 
other users which will be allowed to logon to the Enterprise Manager. 
 
To grant a user logon permissions, click the Add user icon or right-click inside the Used Roles 
tab and in the context menu click Add. 
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In the Search Active Directory pop-up dialog click Find. Locate the desired user in the list 
and click Select.  
 

 
 
The user will be displayed on the User Roles tab. Select the desired user and manage its 
roles by checking Allow for: 

¶ Logon - user will be able to logon to the EM and manage Archive Manager 

¶ Logon to PST Importer ï user will be able to launch PST Importer 

¶ Modify roles ï user will be able to manage user roles on this tab 

¶ Access mailbox browser ï user will have access to archiving/restoring, i.e. 
the user will be able to enter the Archive view 

¶ Modify mailbox permission ï user will be able to modify permissions in 
Mailbox Rights Manager (see the section ñMailbox Rights Managerò) 

NOTE: If neither Allow nor Deny is checked, the role is denied. 
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Tools/Settings 
 
In addition to global settings specified under the Tools/Options as described above there are 
more global settings available under Tools/Settings. Global settings apply if no specific 
archiving settings are selected. 
Run Enterprise Manager (EM) (click Start/ Programs/ Metalogix / Archive Manager 
Exchange Edition / Enterprise Manager). In the EM window click on the Tools menu, and 
then click on Settings to open the Settings window.  
 

Archive/Restore tab 
 
On this tab you may: 

¶ specify the format the body of emails will be saved in; 

¶ allow re-archiving of delayed or backup shortcuts 
 

 

 
 
Business critical emails often have to be stored for long periods of time. At the moment it is still 
unclear as to whether an email in msg format can also be read in ten years. Therefore Archive 
Manage Exchange Edition supports long term archiving using TXT and HTML formats. 
If you want to save emails not only in the msg format, select the Save message body as a 
file check box. Then the body of the email will be saved in msg and txt format. 
If you check the Save message body as a file check box and also the Use HTML check box, 
emails will be saved in msg and HTML format. 
 
 
Usually, when archived with Archive Manager emails are replaced with shortcuts on the 
Exchange Server. In some cases you may have decided to archive the emails and at the same 
time not to create shortcuts for them or delay the shortcut creation (this is done via retention 
categories, see the section ñRetention categories and their usageò). In such cases the emails 
are copied to archive and remain unchanged also in Exchange Server (no shortcuts are 
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created). In specific cases you may want to re-archive such items to save any possible 
modifications made after archiving. Should you wish to re-archive these items (possible only 
manually), it is necessary to allow it:  
Allow re-archiving of delayed shortcuts is checked ï it will be possible to MANUALLY re-
archive emails which have been already archived via retention category with ñDelay shortcut 
creationò settings. 
Allow re-archiving of backup shortcuts is checked ï it will be possible to MANUALLY re-
archive items which have been already archived via retention category with ñKeep original 
emailò settings.  
 
NOTE: Both above mentioned options are only valid while the Enterprise Manager is running. 
When the application is restarted, these options are reset. 
 
 

 

Visualization tab 
 
If you select Auto in the Size units when displayed or Size units when set dropdown 
menus, then the size of the files will be displayed correspondingly: in B, KB, or in MB. 
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Others tab 
 
On this tab you may set the set the Service status refresh rate. It is set by default to 10 
second. This means that every 10 seconds the status of services will be checked and the list 
of services displayed in Status view will be ñrefreshedò. 
Here you may also set the type of CSV export/import column delimiter. The CSV column 
delimiter can be set to a comma (,) or to a semicolon (;). You should check your MS Office 
settings first, and then set it accordingly.  
 
Furthermore, on this tab you have an option to enable direct archiving. To enable it, simply 
select the Show Direct Archive check box. Otherwise, no DirectArchive tab would be 
displayed in the Manager view. Therefore if you want to use direct archiving, please select the 
Show Direct Archive and add the desired mailboxes/groups onto that tab. 
 
NOTE: Enabling the direct archiving feature is important as it allows incoming email archiving 
for selected groups or mailboxes (see the section ñDirectArchive tabò). This feature is optional 
and to use it, you need to select the DirectArchive option when running installation of Archive 
Manage Exchange Edition on your MS Exchange Server.However, this feature shall be used 
carefully in cases where no antivirus software is available, as you might then be archiving 
spam messages as well. 
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Tools 
 
 
On the Tools menu of Enterprise Manager (EM) you will find: 

ǒ Mailbox Rights Manager which handles user access rights for the Archive 
Manager WEB Interface. WEB Interface is used for viewing archived emails 
over the Internet and for their full-text searching. 

ǒ Check Mailboxes command which you can use to check mailbox connection 
to MS Exchange Server 

ǒ Create folders wizard which can create Outlook folders for some or all your 
users. 

ǒ Export tasks option designed for checking the status of exporting and 
managing export tasks. By Export tasks we mean exporting of items found via 
Advanced search or in the WebArchive to mailbox or PST file. (For more 
information on how to export found items see the section ñAdvanced searchò.) 

ǒ Statistics option which helps administrator get an overview of number of 
items archived during a specific hours / days / weeks / months / years. 

ǒ Addressbook Manager which manages synchronization of your servers, 
groups and mailboxes with Active Directory. 

ǒ Options command, which is important for configuring global archiving settings 
(see the previous section ñGlobal archiving settingsò). 

ǒ Settings under which additional global settings for EM can be configured (see 
the previous section ñGlobal archiving settingsò). 

 
 
 

Mailbox Rights Manager 
 
By using the Mailbox Rights Manager tool you manage mailbox rights in the ArchiveWeb 
which is used for viewing and full-text searching in archived emails over the Internet. Those 
rights can be assigned individually. The respective users can then view and full-text search 
archived emails of other users in ArchiveWeb (AW). 
NOTE: Mailbox rights Manager for indivudial mailboxes can be opened also from 
Addressbook Manager / Mailboxes tab. Right-click the desired mailbox in the list view and 
select Permissions. 
 
Only users with appropriate user role can administer rights in Mailbox Rights Manager. User 
roles are assigned on the Tools / Options / User Roles tab. To manage Mailbox Rights 
Manager, the user has the Modify Mailbox Permission option Allowed. 
 
NOTE: After the permission synchronization has run (manual or scheduled in Tools / 
Addressbook Manager), Mailbox Rights Manager displays also mailbox permissions which 
are set in the Exchange Server. These are also applicable to AW. 
 
 
To manage rights of a desired user to view and full-text search in other usersô mailboxes over 
the Archive Manager Web Interface: 

1. On the Tools menu, click Mailbox Rights Manager. The Mailbox Rights 
Manager window opens, with an empty list. Click, for instance, on the All tab, 
to get a list of all mailboxes displayed, as shown below. By clicking any other 
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tab, e.g. PQRS, a list of mailboxes starting with the letters P, Q, R and S will be 
displayed. Those tabs serve as a filter; moreover, the text box located directly 
beneath the tabs serves as an additional filter. Simply enter any string to 
display only mailboxes containing that respective string in their mailbox names. 

 

 
 

2. Select the desired mailbox in the list, right-click it and in the context menu 
select Properties.  
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3. The Properties window opens. In the Properties window you will find three 
tabs: Mailbox Permissions tab; Folder Permissions tab; and the 
Permissions tab. 
a) On the Mailbox security tab you may specify those users who will have 

access to this specific mailbox; 
b) On the Folder security tab you may specify those users who will have 

access to specific folders only; 
c) On the Access tab you may view all those users whose mailboxes may be 

accessed by this user. 
 

a) For instance, to give access to Martin Kowenôs mailbox, open its Properties 
window as described above, and then click on the Mailbox security tab. On 
the Mailbox security tab, click on the Add button to add desired users who 
will access Martin Kowenôs mailbox. 
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Upon clicking the Add button, the Select mailbox or group window opens. 
Enter the desired user (mailbox-name) in the Type in the name or select 
from the list text box or double-click the user from the list. The mailbox will 
appear in the Selected objects text box. In the same way you can add several 
objects. Confirm by clicking OK. 
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The respective mailbox will be added onto the Mailbox security tab. Click 
Apply and then OK. Added mailboxes will have access to Martin Kowenôs 
mailbox. 
NOTE: Permissions manually added via Mailbox Rights Manager are displayed 
bold. Userôs permissions to other usersô folders or mailboxes set in Exchange 
Server are also listed (not bold) if synchronization of permissions has run 
(Tools / Addressbook Manager). 
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b) To give access to a folder only, simply click on the Folder security tab in 
Martin Kowenôs Properties window. Select the desired folder, e.g. Inbox. Click 
on the Add button and proceed as described for mailbox permissions. Users 
added onto this tab will only have access to this specific folder belonging to 
Martin Kowen. 
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Folders accessible by other users are displayed in green, as shown below, 
where Inbox can be accessed by Robert Parcely. You may, of course, specify 
access to folders by different users. 
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c) To see all users whose mailboxes/folders can be accessed and viewed by 
Martin Kowen, simply click on the Access tab in Martin Kowenôs Properties 
window. 
As shown on the screenshot below, Martin Kowen has access to the mailbox of 
Administrator and to the public_vmxdemo which represents public folders on 
the VMXDEMO server; furthermore, he has access to Jerry McLeanôs Inbox. 
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Check Mailboxes 

 
The purpose of this tool is to check the connection of mailboxes to the MS Exchange Server, 
for instance after: 

¶ the first installation of Archive Manage Exchange Edition 

¶ configuration changes on MS Exchange Server, e.g. mailbox migration 
 

1. On the Tools menu click Check mailboxes.  
2. The Check mailbox connections wizard opens. The list view displays mailboxes 

synchronized with Archive Manager Exchange Edition. Check 
 

- Include deleted mailboxes to display also mailboxes that were deleted 
- Include deactivated mailboxes to display also deactivated ones in the 

listview 
 
Select those mailboxes for which you want to check connection to Exchange 
server. Click Next. 

 

 
 

 
 
 
 

Create folders 

 
Create folders wizard helps you to adjust MS Outlook to your needs as it can create a new 
folder in mailboxes of all or some of the users synchronized in the Addressbook Manager. 
 
To create MS Outlook folder for your users, follow the next steps: 

1. On the Tools menu click Create Folders. The Create Folder wizard opens. In 
the first window of the wizard type in the name of the new folder in the Folder to 
create text box. In the Folder type down-drop box select where you want to 
create the folder (in Mail, Calendar,é) 
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2. Further there are two possibilities available: 
a. To create the folder for all users synchronized in the Addressbook 

Manager (see the section ñBefore archiving with Enterprise Managerò), 
check All mailboxes radio button. Click Next. When the folder 
creation is finished click Close. 

 
b. To create the folder just for some of the synchronized users check the 

Select mailboxes from the list radio button and click Next. In the 
next window select the users for which you wish to create the folder. 
Click Next. When the processing is finished click Close. 

 
3. It is possible to set a home page for the created folder, e.g. ArchiveWeb 

application can be available in this folder for the users. To do so, check the Set 
folder home page check box and in the text box enter the desired link. 
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Export tasks 
 
With Archive Manage Exchange Edition you can export emails found via Advanced search to 
mailbox or PST file (see the section ñAdvanced searchò). Emails can be exported also in 
ArchiveWeb application. Status of all export tasks can be checked when you click Tools / 
Export tasks on the main menu. 
In this section you will find a short overview of the Export tasks. For comprehensive guide to 
found items exporting see the section ñAdvanced searchò. 
 
After clicking Tools / Export tasks the Export tasks dialog opens. Besides checking the 
status of the export tasks administrator can: 

o change properties of the task 
o create new task 
o start / stop the task 
o add documents to the task etc. 

 
To manage the existing export tasks or create a new one: 

1. Click Tools / Export tasks on the menu bar of Enterprise Manager. 
2. Export tasks window opens listing all existing export tasks. In the Status 

column, check the export task status, e.g. finished, waiting, processing etc. 
3. Right-click inside the list view to open the context menu. 

 

 
 

4. In the context menu you can choose: 

¶ Properties ï Properties dialog opens and you can change settings of the 
given task: 

o Export task tab - for detailed information on the settings see the 
section ñAdvance search / Exporting found itemsò 

o Documents tab ï displays task statistics; in case of PST export you 
can check the Total PST size and set the Maximum size of one file, e.i. 
you can limit the PST file size when exporting. By default it is 1.9 GB. If 
the exported amount is above this limit, a new file is created (i.e. the 
exported data are segmented into smaller files). In other words, not 
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only one PST file is created, but x PST files, all of them are less than 
1.9 GB in size. 

¶ Create new task ï Export wizard opens. However, there are no documents 
included for the new task. Found items saved beforehand have to be loaded 
first. To do so, click the Load button. Then click Next and specify the settings 
for the new task. 

 

 
 

 

¶ Remove task ï removing the task will also remove all related files (log files, 
documents list files, PST files etc.) 

¶ Refresh ï refreshes the view 

¶ Task ï you can Start a waiting tasks, Stop a task, Add documents to the task 
(i.e. add another search result to the export task) as well as Clear documents 
from the given task 

¶ Add / remove columns ï customize the list view 
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Statistics 
 
 
Statistics functionality helps the administrator get an overview of: 

¶ number of items archived during a specific period (Archived messages view) 

¶ size of individual mailboxes and their archive (Archived size view) 
 
To display the statistic overview in Enterprise Manager, click Tools / Statistics on the main 
menu. The Statistics window opens by default in the Archived messages view. Switch 
between views in the left pane of the window. 
 
 
To get statistics on the number of archived messages, select the Archived messages view in 
the left pane. In the Date range section define the time period for which you want to generate 
the statistics. If you have selected ñIntervalò, specify the time span in the From / to text boxes 
(either overwrite the dates or click the down arrows to select desired days in the calendar). 
 
As a next step sort the data by hours / days / weeks / months / years as you select the 
respective option in the Grouping section. Finally click Apply. 
 

 
 
The statistical data for the chosen time period will be represented in the form of a graph and 
on the Data tab as a statistics table. To export the statistical data, click the Export button and 
then select the export folder. 
 
Tips & Tricks: Use the icons in the upper bar of the Statistics window to switch between bar 

graph ( ) and line graph ( ).  
It is also possible to ZOOM the parts of the graph. Simply click inside the graph and draw the 
cursor to select the part which you want to zoom. To un-zoom, righ-click inside the graph. In 
the context menu select Un-Zoom. The graph context menu offers also additional commands 
as Print, Save Image As etc. 
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To get an overview of individual mailboxes, their size of messages, archive, shortcuts etc. 
switch to the Archive size view in the left pane. On the Mailboxes tab check the mailboxes 
for which you want to generate the statistics and click Run. 
 
NOTE: If you check the Include Exchange size check box the report will contain a new 
column: current size of the mailbox on Exchange. This helps you to report the size of the 
mailbox after archivin. 
 

 
 
The statistical data for the chosen mailboxes will be represented in the form of a graph and on 
the Data tab as a statistics table. Colors in the graph represent the following: 

 red ï the size of all messages of the given mailbox 
 green ï the size of the mailbox in the HSM store, i.e. archive size 
 yellow ï the shortcut size, i.e. the size of shortcuts left in the Exchange server 

 
 

NOTE: Overview reports for mailboxes can be created also in the Manager view on the 
Settings / Archive size report tab. The Export wizard on that tab offers advanced 
functionality. The report can be exported and adjusted to the administratorôs needs (see the 
ñArchive size reportò section in the ñSettings tabò chapter). 
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Addressbook Manager 
 
Before archiving emails you need to synchronize your servers, groups and mailboxes which 
you intended to archive with the Archive Manage Exchange Edition. The Addressbook 
Manager (AM) was designed especially for that purpose. Additionally, in AM you can schedule 
automatic synchronization to keep the Archive Manager database up to date and synchronized 
with the Active Directory. 
 
On the AM tabs you can manage the following: 

o General settings tab ï configuring automatic synchronization of Archive 
Manage Exchange Edition with Active Directory 

o Favorites tab ï settings related to automatic synchronization 
o Servers tab ï managing servers synchronized with Archive Manage 

Exchange Edition and importing new servers 
o Groups tab ï managing groups synchronized with Archive Manager, creating 

user-defined groups and importing of Active Directory groups 
o Mailboxes tab ï managing mailboxes synchronized with Archive Manager 

and importing new users 
 
NOTE: The process of importing new servers, groups and mailboxes to AM is described in 
detail in the Appendix in the section ñImporting users to Archive Manage Exchange Editionò. 
 
 

 

General settings ï automatic synchronization 
 

Before archiving you have to import servers, groups and mailboxes which you want to archive 
to Archive Manage Exchange Edition. This process is described in Appendix in the ñImporting 
users to Archive Manage Exchange Editionò section. 
After initial import, the Addressbook Manager tool can run the synchronization of the Active 
Directory mailboxes and groups automatically in the background. It is very important to 
schedule the automatic synchronization and thus keep your groups and mailboxes imported to 
Archive Manager Addressbook Manager always up to date. Automatic synchronization is 
scheduled and runs with settings predefined on the General settings tab of Addressbook 
Manager. 
 
To schedule automatic synchronization: 

1. Run the Addressbook Manager from Tools / Addressbook Manager or click 
the AM icon on the toolbar. 

2. Switch to the General settings tab of the Addressbook Manager. 
3. In the Base LDAP path text field enter the NETbios name of your Domain 

Controller, e.g. LDAP://vmxdemo. Then click Save.  
 
NOTE: If the name of the domain controller will change in the future you have to retype it on 
this field and click the Save button. 
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4. To set synchronization parameters, click the Settings button in the Automatic 
synchronization parameters section. The Addressbook synchronization 
options dialog appears. On the Updating rules, Monitoring, Advanced and 
Scheduling tab define the automatic synchronization settings as follows: 
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5. On the Update rules tab (the screenshot above) set the update rules for 

mailboxes and groups. To allow the mailboxes and groups update at the 
automatic synchronization and thus keep them up to date, select Allow mailbox 
update and Allow group update check boxes. Otherwise groups and mailboxes 
will be preserved in Archive Manager database without any modification. 
Additional settings: 

¶ Force mailbox update: if selected, all mailboxes will be updated with the 
values from Active Directory (regardless of the modification date) 

¶ Force group update: if selected, all groups will be updated with the values 
from Active Directory (regardless of the modification date) 

 
New groups default options 
This section will define properties for automatically imported new groups that may be created 
in Active Directory. New groups are automatically imported if they were created: 

- in monitored CNs and OUs (specified on Favorites tab) or 
- as a subgroups of already synchronized groups. 

NOTE: You must allow importing of new subgroups for already synchronized 
groups. It can be done in Properties window of the respective group on the 
Advanced tab ï Automatically import group members must be checked. 
 

Specify new groups settings which will be applied when these groups are synchronized in the 
future automatically or manually:  

¶ Refresh references: it is recommended to select this check box so that 
references of the group will be always updated in the Archive Manager at 
synchronization  

¶ Automatically import group members: if selected, all members (mailboxes and 
groups) of groups will be always automatically imported at synchronization 

¶ Automatically import mailbox members: if selected, the synchronization 
process will always import only the mailbox members of the group 

 

 

 

6. When really necessary, on the Monitoring tab you can allow the automatic 
importing of groups or mailboxes from specific OUs or CNs in Active directory into 
Archive Manage Exchange Edition. To do so, check the Allow monitoring 
Organizational units check box. CHECK ALSO THE CHECK BOXES FOR THE 
DESIRED OUs and CNs IN THE LIST VIEW. 

 
NOTE: In the list view you can see a list of LDAP paths to the OUs or CNs you have defined 
on the Favorites tab of the Addressbook Manager tool. On the Favorites tab you have also 
specified whether you plan to import only mailboxes from the respective OU, only groups, or 
both when the synchronization runs. 
 
You can include security groups in synchronization (Include security groups check box) or 
include only groups that have an email address (Include groups with email address check 
box).  
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7. On the Advanced tab you can define whether you want a detailed report to be 
generated for each day of automatic synchronization. The detailed reports are 
saved in the same folder as other logs for Archive Manager Exchange Edition 
(C:\Program Files\ PAM\Log). Click Apply. 
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8. On the Scheduling tab define, by clicking the relevant fields, in which days and 

hours of the week the automatic synchronization should start. Started at the 
defined hour, the process will be running until it is finished. It is not necessary to 
define a time span of several hours because in that case the synchronization will 
start every hour of the given time span.  
We recommend running the synchronization out of working hours once a day (see 
the screenshot below). Do not forget to check the Use scheduled 
synchronization text box. Click Apply. When finished, click OK. 

 

 
 
 

9. Now you will set up automatic synchronization of permissions. This 
synchronization ensures that any permission you set for your users will be 
applied. To do that, click the second Settings button (Addressbook Manager / 
General settings tab / Automatic permission synchronization parameters 
section). New window opens.  

 
On the Selection tab you choose which permissions from Active Directory will be 
synchronizes at automatic permission synchronization. We recommend checking 
all options here. If permissions are not synchronized, users will not be able e.g. to 
access archived items in additional mailboxes/folders for which they have access 
rights. 
 
Allow mailbox permission synchronization ï synchronize permissions for 

additional mailboxes 
Allow MAPI permission synchronization ï synchronize permissions for 

additional folders 
Allow Public Folder MAPI permission 
synchronization 

ï synchronize permissions for 
Public Folders 
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To read and synchronize the above mentioned permissions, Archive Manager 
Extension has to be installed on an Exchange Server in your environment. Name 
of the Exchange server with Archive Manager Extension installed has to be 
specified in the Name of the server to read the permissions from text box. 
PAM Extension installation is one of the post-installation tasks (see the ñArchive 
Manage Exchange Edition Install Package Guideò). Archive Manager Extension is 
mandatory as it is providing the necessary proxy application to read permissions 
remotely. 
 

 
 

10. Finally, on the Scheduling tab define the exact time when the automatic 
permission synchronization should start. Started at the defined hour, the process 
will be running until it is finished. It is not necessary to define a time span of 
several hours because in that case the synchronization will start every hour of the 
given time span. 
We recommend running this automatic permission synchronization after the 
automatic synchronization once a day. Click Apply, then OK. 

 
 
 
 
 

Favorites - LDAP path Monitoring 
 

Before archiving you have to import servers, groups and mailboxes which you want to archive 
to Archive Manage Exchange Edition. This process is described in Appendix in the ñImporting 
users to Archive Manage Exchange Editionò section. 
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When groups and mailoxes are imported in AM you may want to define which specific Active 
Directory CNs and OUs should be monitored at automatic or manual synchronization. 
Depending on the settings, groups and/or mailboxes residing in the monitored CNs and OUs 
will be synchronized when synchronization runs. You can define all LDAP paths which you 
want to monitor in this way on the Favorite tab of Addressbook Manager: 
 

1. Open the Addressbook Manager. 
2. Switch to the Favorites tab and click the Add button. 
3. The Active Directory container window pops-up. Use the browse button to 

add the LDAP path to the container you want to monitor.  
4. Back in the Active Directory container window check the Monitor check box 

to allow automatic synchronization. 
 
IMPORTANT NOTE: For automatic importing to take place, the relevant settings must be 
specified also in the General settings on the Monitor tab (see the section ñGeneral settings ï 
automatic synchronizationò). 
 
Other available settings: 

¶ Monitor recursively: if selected, all the child OUs of the container will inherit the 
settings 

¶ Monitor Mailboxes: if selected, automatic synchronization for all mailboxes found 
in this container will be allowed 

¶ Monitor Groups: if selected, automatic synchronization for all groups found in 
this container will be allowed 
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Server tab 
 
On the Servers tab of the AM administrator can see all Exchange servers synchronized with 
Archive Manage Exchange Edition. Exchange servers can be purged from Archive Manager or 
imported to Archive Manager on this tab. All the tasks as well as server properties are 
accessible through the context menu. 
 
NOTE: The process of importing Exchange servers to Archive Manage Exchange Edition is 
described in the Appendix in the section ñImporting users to Archive Manage Exchange 
Editionò. 
 
To check server properties: 

1. Open the Addressbook Manager from the Tools menu bar. 
2. Switch to the Servers tab. 
3. To open the Properties window for any of your synchronized Exchange 

servers: 
- double-click the relevant server or 
- right-click the relevant server and select Properties from the context menu  

 
 
NOTE: In the server list view, servers excluded from synchonization are displayed in green 
( ) and deleted servers are displayed in orange ( ). 
 

4. The Properties window opens.  
 

General tab 
 ǒ always check the Include this server in synchronization otherwise the server 

will not be synchronized 
 ǒ it is recommended to enter 0 in the Mailbox limit text box 

 
NOTE: Notice please that it is possible to set limit for mailboxes individually. For 
more information see the ñThreshold tabò section. 
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Advanced tab 
 ǒ displays configuration path and server distinguished name 
 ǒ the Show button opens window with more detailed information on your server 

(from registry) 
 ǒ the Update now button updates server data immediately 
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Groups tab 
 
On the Groups tab of the AM administrator can see all Active Directory groups synchronized 
with Archive Manage Exchange Edition. Groups can be purged from Archive Manager or 
imported to Archive Manager on this tab. Moreover, a user-definied group can be created. All 
the tasks as well as group properties are accessible through the context menu. 
 
NOTE: The process of importing groups to Archive Manager is described in the Appendix in 
the section ñImporting users to Archive Manage Exchange Editionò. 
 
 
To check group membership or settings: 

1. Open the Addressbook Manager from the Tools menu bar. 
2. Switch to the Groups tab. 

NOTE: You can display only filtered list of mailboxes. To do so, click the filter 

icon ( ) on the toolbar. Create the filter in the same way as on the Groups tab 
of EM. 

3. To open the Properties window for any of your synchronized groups: 
- double-click the relevant group or 
- right-click the relevant group on the Groups tab of Addressbook 

Manager and select Properties from the context menu 
NOTE: In the groups list view, manually created groups are displayed in green 
( ) and deleted groups are displayed in orange ( ). 

 

 
 

4. The Properties window opens. 
 
NOTE: There can be two kinds of groups in Addressbook Manager ï groups imported from 
Active Directory and user defined Archive Manager groups. Some features are applicable only 
to Active Directory groups (Advanced tab) others just for user defined Archive Manager 
groups (Members tab). 
 

General tab 
 ǒ general information (display name, alias, e-mail, Active Directory folder etc.) 
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Member of tab 
 ǒ list of all groups which your group is a member of 
Members tab 
 ǒ used for adding new members to user defined Archive Manager group: right-

click inside the list view and select Add members from the context menu 
Advanced tab 
 ǒ active just for Active Directory group (not for user defined Archive Manager 

group) 
 ǒ in the Automatic updates section define groupôs settings for manual and 

automatic synchronization: 
o Allow update of references - we recommend clicking this check box, 

so that the reference of the respective groups (e.g. membership 
changes in Active Directory) will be always updated in the Archive 
Manager database when the synchronization runs 

o Automatically import group members ï we recommend un-checking 
this option unless you plan to populate the Archive Manager database 
with all Active Directory account members of this group (mailboxes and 
groups) 

o Automatically import mailbox members ï we recommend un-
checking this option unless you plan to populate the Archive Manager 
database with all Active Directory accounts with a mailbox that are 
members of this group. 

 ǒ the Update now button updates group references immediately 
 ǒ the Show button opens window with more detailed information on your group 

(from registry) 

 

General tab Advanced tab 
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Mailboxes tab 
 
On the Mailboxes tab of the AM administrator can see all mailboxes synchronized with 
Archive Manage Exchange Edition. Mailboxes can be deactivated or even purged from AM. If 
some of your users in Active Directory migrate, their name and/or location is changed, Archive 
Manager can mirror these changes. Also new mailboxes can be imported to Archive Manager 
on this tab. All the tasks as well as group properties are accessible through the context menu. 
Also Mailbox Rights Manager for individual mailboxes can be opened from the context menu 
by clicking Permissions. 
 
NOTE: The process of importing individual mailboxes to Archive Manager is described in the 
Appendix in the section ñImporting users to Archive Manage Exchange Editionò. 
 
To check or specify mailbox settings: 

1. Open the Addressbook Manager from the Tools menu bar. 
2. Switch to the Mailboxes tab. 

NOTE: You can display only filtered list of mailboxes. To do so, click the filter 

icon ( ) on the toolbar. Create the filter in the same way as on the Groups tab 
of EM. 

3. To open the Properties window for any of your synchronized mailboxes: 
- double-click the relevant mailbox or 
- right-click the relevant mailbox on the Mailboxes tab of Addressbook 

Manager and select Properties from the context menu 
4. The Properties window opens. 

 
NOTE: In the list view on the Mailboxes tab of the Addressbook Manager you can see a 
mailbox called public_NAMEOFEXCHANGESERVER. This mailbox actually stands for the 

public folders of the respective MS Exchange server. It is always highlighted in dark blue ( ) 
in the list. Some features accessible for mailboxes are not applicable for this folder. 
Mailboxes which are deactivated are displayed in light blue ( ). 
 

General tab 
 ǒ general information (display name, alias, e-mail etc.) 
 ǒ If Mailbox is activated is unchecked, no archive/restore is possible; mailbox is 

deactivated 
 ǒ Checked Mailbox is on legal hold check box puts the mailbox on legal hold; 

no modification of archived emails is allowed  
 ǒ in the Mailbox type down-drop box specify if it is normal or journal mailbox 
Member of tab 
 ǒ list of all groups which your mailbox is a member of 
Other tab 
 ǒ check the Lock this mailbox check box to set this mailbox as read only; the 

mailbox will not be updated at synchronization 
 ǒ Creation date is a date when the mailbox was imported into Addressbook 

Manager 
 ǒ Modification date is a date of last mailbox modification  
 ǒ mailbox is usually marked as deleted (Mailbox is deleted check box) if the 

automatic updates cannot find the Active Directory object specified by the LDAP 
path 

 ǒ Mailbox size display the size of the mailbox in Exchange Server 
 ǒ Limit defined on mailbox level and Limit defined on store level display limits 

set in Exchange Server. If set, Mailbox limit has a higher priority than Store 
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limit 
 
NOTE: The limit is relevant for the mailboxes added onto the Threshold tab 
(Enterprise Manager / Manager view / Settings / Threshold). For more 
information see the section ñThreshold tabò. 

 
 

 
 

Advanced tab 
 ǒ the Show button opens window with more detailed information on your server 

(from registry) 
 ǒ the Update now button updates mailbox references immediately 
 ǒ click the Stats button to open the Mailbox statistics window where you can 

check number of archived or deleted messages in mailbox folders 
 ǒ click the Permissions button to manage the mailbox permission rights. The 

same settings are accessible also from the Enterprise manager / Tools / 
Mailbox Rights Manager. For detailed information see the section ñMailbox 
Rights Managerò. 
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Deactivating mailboxes 
 

You can deactivate archiving process for some of your mailboxes, e.g. to reclaim a license or 
to prevent mailbox from archiving. In that case open the Addressbook Manager tool and 
switch to the Mailboxes tab. Right-click the relevant mailbox and select Tasks / Deactivate 
mailbox from the context menu. No archive/restore is then possible. 
NOTE: Mailbox can be activated/deactivated also on the Properties / General tab. 

  
Mailbox statistics 

  
    Advanced tab 
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A deactivated mailbox in Archive Manage Exchange Edition is always displayed with a 

different icon ( ) and it is highlighted in light blue. 
 

Purging mailboxes 
 

In case you have included by mistake a mailbox in synchronization, you can choose to delete 
it completely from the Archive Manager database. Right-click the mailbox in the Addressbook 
Manager, then select Tasks / Purge mailbox.  
The Addressbook Manager will not allow you to purge any of the Archie Manager mailboxes 
if it contains at least one email archived. Purging only works for mailboxes in which no email 
was archived. 

 
 

Migrating mailboxes 
 

If you have made some radical changes in your Active Directory, e.g. completely migrating the 
data from a use to another, or building a new parallel Active Directory in a new domain and 
need to migrate users from your current one to it, you may want to reflect these changes in the 
Archive Manager database as well. 
 
To migrate an archived mailbox, right-click on it in the Addressbook Manager on the 
Mailboxes tab and then select Tasks / Migrate Mailbox. 
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Then find the migration target new mailbox by typing its name in the Look for name field and 
then clicking Find. 
 

 
 

Finally, highlight your target new user and click Select. 
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If you really want to migrate, click Yes. 

 
 

A last notification appears stating what will be changed in the Archive Manager database with 
regards to the migrated mailbox. Click Yes if you want to accept these changes. The migration 
terminates, click OK. 

 
 
 
 

Synchronizing mailbox folder permissions 
 

From the context menu on the Mailboxes tab you can synchronize folder permissions for 
individual mailboxes, i.e. userôs persmissions to other usersô mailbox folders are synchronized 
with Archive Manager database. 
 
NOTE: Mailbox folder permissions can be synchronized for all maiboxes at once as well. To 
do so, click the Synchronization option on the menu bar of AM. From the down-drop menu 
select Synchronize mailbox folder permissions option. 

 

Manual synchronization ï synchronization menu 
 

Except automatic synchronization which is set on the General settings tab you can run also 
manual one in the Addressbook Manager. Other types of synchronization for various 
permissions are also accessible. Administrator can run the desired synchronization from the 
synchronization menu. To open the menu, click the Synchronization on the AM menu bar. 

 
Manual synchronization of mailboxes and groups 

 
As written in the section ñGeneral Settings ï automatic synchronizationò you can set the 
synchronization to run in the background to keep groups and mailboxes in Archive Manage 
Exchange Edition up to date. However, you can run the synchronization also manually. The 
manual synchronization can be started only if the automatic synchronization is not running at 
the moment. 
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To run the manual synchronization: 
In the Addressbook Manager click Synchronize on the menu bar and choose Synchronize 
addressbook from the down-drop menu. The Addressbook synchronization settings 
dialog will appear: 

 

 

NOTE: The Addressbook synchronization settings dialog opens with the settings defined 
on the General Settings tab of Addressbook Manager. Nevertheless, you may change these 
settings. In comparison with the General Settings and automatic synchronization, the manual 
synchronization offers two more options ï Change RDN and Allow mailbox migration. 

 
 

We describe available synchronization settings as they are listed in the dialog one by one 
further. 
 
NOTE: Usually, when running manual synchronization to keep the Active Directory consistent 
with Archive Manage Exchange Edition, it is recommended to check Allow mailbox update, 
Allow group update and Refresh references check boxes (see the picture). 
 
Mailbox update rules 
In this section you can allow mailbox update when the synchronization runs. We recommend 
selecting the Allow mailbox update check box, so that the modifications made in Active 
Directory will also be reflected in the Archive Manager database at the synchronization. 
Leaving this check box unchecked will preserve the mailboxes in the Archive Manager 
database, not allowing any modification. 

 

 

 
General tab Advanced tab 

 




























































































































































































































































































































































































































